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Example Problem 
Given the logic equation Y = A*/B + /C, implement this equation using a two input AND gate, a 
two input OR gate and two inverters under the Quartus environment. Upon completion of the 
schematic entry portion of the example, simulate the circuit and print out copies of the circuit & 
simulation results.  Draw a Logic Table for the inputs & output and compare it with the 
simulation results. 
I. Circuit Design Tutorial (using the Schematic Editor) 
A. New Project Design Creation 
1. Setup a ‘lab1_ex’ directory on your PC to hold your design & simulation files. 
2. Launch the Altera Quartus software under Windows. 
3. Select the pull-down button “File” and “New Project Wizard ...”.  Select “Next”.  Now use 

the “…” button to browse and select the directory you created in step number 1.  Name the 
project lab1_ex.  (This may already be done for you.  This should also make the top-level 
design entity name lab1_ex.  If not, again type in lab1_ex.)  Select “Finish”. 

4. Select the pull-down button “File” and “New | Device Design Files | Block 
Diagram/Schematic File”.  Press OK.  This should open a palette where you will design your 
circuit.  This palette is designated “Block1.bdf”. 

5. Select the pull-down button “file” and save the graphic design file “lab1_ex” in your 
‘lab1_ex’ project directory created in step #1 (by selecting “Save As”).  The file will be 
given the bdf extension; bdf stands for “block design file” and contains schematics, symbols 
or block diagrams.   

 
Special Note: You can remove the grid dots (or add them back) by selecting the pull-down 
button “View” and then select “Show Guidelines.” 
B. Adding Text 
1. Select the “A” below the arrow to the left of your Block Diagram/Schematic File window 

(also known as the palette). 
2. Select a point near the top left in the window with the left mouse key.  Type your name and 

then hit the “Enter” key.   
3. Type Lab 1 Part 1 and then hit the “Enter” key.  
4. Type your section number and then hit the “Enter” key.  
5. Type TA: Name, where Name is replaced by your TA’s first and last name.  Hit the “Enter” 

key.  
6. Type Description: and then the following equation, Y = A * /B + /C , and then hit the 

“Enter” key. 
7. Hit the “Esc” (escape) key to end text additions. 

C. Component Selection Process and Moving Components 
1. With your mouse pointing inside the palette, double-click (with the left mouse key) [or click 

the right mouse key and select “Insert | Symbol”].  The “Symbol” dialog box will appear.  
This window lists the available Altera libraries. 

2. Select the + icon to expand the “/altera/80sp1/quartus1/libraries” folder. 
3. Select the + icon to expand the “primitives” folder and then expand the “logic” folder. 
4. In the logic folder, select the “and2” component by double clicking on it (or by selecting it 

with a single click, then selecting “OK”).  (If you wanted to add multiple 2-input AND gates, 
you could select the “Repeat-insert mode” box.) 
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5. Click the pointer at the desired location in the Block Diagram/Schematic Editor window to 
insert the AND symbol into the design file. 

6. Repeat steps 1-5 to enter an OR (or2) gate and two Level-Shifter (not) gates. 
7. Select the magnifying glass to the left of your Block Diagram/Schematic Editor window.  

Select a point in the window with the left mouse button.  Notice that the image gets larger 
with the center of the enlargement at the point you selected.  Now select a point in the 
window with the right mouse button.  Notice that the image gets smaller with the center of 
the enlargement at the point you selected.   

8. Hit the “Esc” (escape) key to end magnifying options or select the arrow symbol to return to 
selection mode.   

9. Rearrange your devices in approximately the placement you would like for the logic diagram 
you are trying to construct.  You can move a component by selecting it with your mouse, 
holding down the left button and moving it to another location on the palette. The window 
should look something like this. 

D. Adding/Deleting Wires 
1. Save your design.  You are now ready “wire up” your circuit.  It is a good idea to save your 

design often, just in case something bad happens (like a Windows crash, a power outage or a 
nasty roommate).  

2. Place your pointer on the output of one of the Level-Shifters and hold the left mouse button 
down.  You should see a cross-hairs or “+” appear at the output.  

3. Drag your pointer to the input of the AND gate.  Every time you release the mouse key, the 
line (wire) ends.  If your wire did not reach the AND gate, you can add to the wire by putting 
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your mouse over an end of the wire and again selecting it with your left mouse button and 
dragging your mouse to another position.   

4. To delete a wire or a portion of a wire, simply click on it (it should change color to indicate 
selection) and press the delete key. 

5. If wires are connected to the component as you are moving it, the wires will drag and stay 
connected to the component.  This is referred to as ‘rubber banding’ and is a feature of all 

major schematic entry design packages. 
6. Add the rest of the wires needed to connect the logic diagram.  Add small input lines where 

the three inputs will be placed and an output line where the output will be placed.  The 
window should look something like this. 

 
E. Adding Input & Output Ports 
1. In the same manner that you placed a gate onto the palette, add three input pins from the 

“Symbol” libraries.  Input pins can be found under “primitives | pin | inputs”.  I would place 
these inputs together, above your logic diagram and just to the right of your name. 

2. Double click on the first input pin name (on the left of the input port symbol) and change it to 
‘A’.    Repeat these two steps to create input ports ‘B’ & ‘C’. 

3.  In the same manner and in the same library that you found the input pins, add an output pin 
from the “Symbol” library.  I put this output pin under and to the right of the input pins.  
Change the pin name to ‘Y’ on the output port. 

4. Now select the top wire near the left most point where you would like to connect signal A.  
The wire should change colors.  Type “A.”  An “A” should appear near the point you 
selected. 

5. Do the same to place “B”, “C” and “Y” at the appropriate points. 
6. The “A” label will connect the input labeled “A” to this wire.  Similar connections are made 

by the labels on the other inputs and output.  The window should look something like the 
below figure. 
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7. Save your design.  You are now ready to proceed to simulation of the circuit.   
8. To print, go to “File | Print…”.  If you want to change what appears on the printout or how it 

appears, go to “File | Page Setup…” change print settings.  Before printing, you can view 

what the print will look like by selecting “File | Print Preview”. 
 
Note:  You could connect the input and output pins directly to your circuit, but I find keeping the 
pins separate from the circuit diagram has advantages that will be discussed later. 
 
Note:  When using Quartus schematic entry (bdf) files as your circuit diagram for constructing 
circuits, always label the parts and pin numbers.  If there are multiples of the same part needed, 
e.g., if you need five 2-input AND gates when the 74’08 only has four per chip, then label the 
two 74’08’s differently, i.e., 08A and 08B. 
 
II. Circuit Compilation and Simulation 

A. Fitting the Design to a Component and Compiling 
1. Before we can simulate the design, we first must run the fitter software to place the design 

into a programmable component.    
a. Select the "Tools" pull-down menu (or right click on the upper toolbar).  Select 

"Customize | Toolbars."  Put a check mark by the "Applications" box (unless one is 
already there) and then select "Close." 

b. Place your mouse over the icon on the top bar that has a small smokestack.   
When you put your mouse over the small smokestack, on the bottom bar of the window you 
should see an icon help message saying “Opens the Compiler Tool window or brings it to the 
foreground.” 

2. Press the smokestack icon (compiler) and the following compiler window should open up.  
(An alternative to this is to select “Processing | Compiler Tool”.)  See the below figure for an 
example of what your screen might look like at this point. 
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3. Select "Assignments | Device" from the pull-down menu.  This will open a new screen.  
Select MAX3000A from the "Family" pull-down list. 

4. Select the “Specific device selected…” and then choose EPM3064ALC44-10, which is the 
device we will be using starting with lab 4 or 5. Select “OK.” 

5. Press the “Start” button in the compiler window.  If the complete compilation process is 
successful, you should see a message back from the compiler that ends with says “Info: 
Quartus II Full Compilation was successful. 0 errors, 0 warnings.”  You can ignore most 
warnings, like “Warning: Timing Analysis does not support the analysis of latches as 
synchronous elements for the currently selected device family.” 

 
6. To view information about the compilation, select “Processing | Compilation Report” (or 

Ctrl-R).  You can also select the icon with a blue diamond with a paper on it. 
 
Special Note: The compilation process consists of several sub-processes that we will breakdown 
and describe at a future date.  For now, we just want you to understand the main function of the 
compiler is to translate the circuit into a set of equations that are fitted or placed into a 
programmable logic device. 
 
B. Creating a Waveform for use with the Simulator 
1. Once the circuit has been fitted into a particular programmable logic device, you can run the 

simulator to check the circuit functionality.   Place your mouse over the icon that looks like a 
blue diamond with a rectangular waveform on it.  You should see an icon message on the 
bottom of the Quartus window that says “Creates a new file in the Waveform Editor”.  Select 
this icon.  (You could also go to “File | New | Verification/Debugging | Vector Waveform 
File” to open up the same waveform window.)   
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2. Now you will stimulate the circuit with a vector of inputs so that you can verify that the 
outputs match those in your voltage table (not your truth table).  (Note: The comparison of 
your simulation should be with your voltage table and not your truth table.) 

3. Save this file: “File | Save”.  The file should be saved under the name lab1_ex with the 
extension .vwf for “Vector Waveform File.. 

4. In the lab1_ex.vwf window, in the left side of the window (under “Name”) double click with 
the left mouse button or click the right mouse button.  The “Insert Node or Bus” window will 
appear.  Select “Node Finder”.  Under “Filter” select “Pins: all” then select “List.”   Hit the 
>> button to copy all the nodes (inputs and outputs) to the “Selected Nodes” list on the right.  
Select OK.  Select OK again. 

5. You should now see the inputs and outputs in the vector waveform file window.  Save this 
file.  The window should look something like below. 

Special Note: The time scale is shown above is in increments of 10ns (ns = nano seconds).  This 
is too small for our parts.  Our parts have a propagation delay of 10ns, i.e., the output does not 
change until 10ns after the inputs change.  If you use the magnifying glass to change the time 
scale, you will find that the total time for the simulation is probably only 100ns.  We need to 
increase this to about 1000ns=1us (us = µs = micro second) for this problem. 
6. Change the default grid size (which is 10ns by default) to 25ns by the following.  Go to the 

“Edit” menu and select “Grid Size”.   Then change the Time period to 25.0ns. 
7. Go to the “Edit” menu and select “End Time”.  Then change the “Time” to 1000ns (or 1us).  

The “us” in Quartus represents “µs” or 10-6 seconds. Now use the magnifying glass to zoom 
out on the waveform window.  NOTE:  When you increase the end time, Quartus simulation 
will repeat it signal values to fill up the total time.  Be sure to review your inputs to verify 
that the simulation is doing what you want. 

8. Using your mouse, click and drag your mouse cursor across the 100 ns segment to select the 
area that is shown as a darkened area in the below screen snapshot. You should see a 
darkened area as result of this operation.  Now press the left toolbar button that has a “1” in 
it.  Now try pressing the left toolbar button that has a “0” in it.  This is how you set the 
highlighted input segment to a particular value.  Set the time segment from 50 ns to 100 ns of 
C to ‘1’ and point & click your mouse to a new area on the window to make the change 
permanent. 
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9. Use the magnifying glass again to increase the segments view to about 500 ns and modify the 
inputs so that they look like the patterns shown below.  Save the file. 

10. The inputs have now been defined and “count” or increment through the binary numbers 000 
to 111 (ABC where A is the most significant bit and C is the least significant bit).  We can 
now run the design simulation at this point.  Note: The Y output is comprised of ‘XXX’ in 
the waveform editor to show that the output is presently undefined.   The reason that it is 
undefined is that although the inputs have been defined, the simulation has not been run yet. 

 
Notes: There are better ways to input data that to enter each of the values you want by changing 
default inputs.   
1. You can group inputs by selecting several and then click the right mouse button, select 

“Grouping” and then select “Group.”  Now you can click the right mouse button, select 
“Value” and then select “Count Value…” or Ctrl+Alt+V.  Select the radix (base you want to 
use, i.e., binary, hexadecimal, or octal), then select Timing and modify the “Count every” 
based on your device.  I use 30ns for my “Count every” value when using a chip with a 10ns 
delay (like the CPLDs that we are presently using in 3701 and 4744.   

2. When you need to generate a clock signal, select the signal you want to use as a clock.  Now 
you can click the right mouse button, select “Value” and then select “Clock” or Ctrl+Alt+K.  
I use 30ns for my “Period” value when using a chip with a 10ns delay (like the CPLDs that 
we are presently using in 3701 and 4744.   

 
Special Note: The above pattern looks like the values that you would have in a truth table (but is 
actually represents a voltage table since the 0 and 1 in the Quartus simulations represent L and H, 
respectively).  You can generate this pattern more easily by grouping the inputs and then giving 
the group a count input sequence.  This technique will be described in class. 
 
C. Running the Simulator and Analyzing the Results  
1. Select “Processing | Simulator Tool”.  Alternatively, you can look for a computer with a 

waveform in it; this symbol is usually next to the smokestack for the “Compiler Tool”.  Make 
sure that the Simulation mode is set to “Timing”.  Check “Overwrite simulation input file 
with simulation results”.  (I also suggest that you check “Glich detection” and use time of 
1.0ns.)  Select “Start”.  When the simulation is complete, you will get a message “Simulator 
was successful.”  Select “OK” and then select “Open” on the “Simulator Tool” window.  
Select “Yes” when prompted about “… overwriting portions of the file …”. 
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2. Resize the “Simulation Waveforms” as desired.  It should look something like this.   
3. To print it, use “File | Print...” or Ctrl-P to print.  To print a selected portion of the simulation, 

select “Options” and then specify both a “From” and “To” time.  See part E of this section 
for more information. 

4. If you haven’t created a logic table for the equation you entered under Quartus, do so now 
and compare these results with those obtained from simulation.  The table that actually is 
needed is a voltage table, but since all the signals were assumed active-high for this example, 
they will look identical (with 0 and 1 replaced with L and H, respectively).  Your simulation 
results from Quartus should match your logic table. 
• For active-low signals, I suggest that you name your signals with a suffix of _L.  For 

active-high signals, I suggest no suffix (or you could use _H).  For example, if X is 
active-low and Z was active-high, use signal names X_L and Z.   

5. When comparing the results of the logic table with that of the simulator, it should be apparent 
that they match but that there is a small delay between when the inputs change and when the 
output changes to the expected value.  For example, if we look at the time segment from 40 
to 80 ns, we see that the inputs C change at 50 ns, but that Y does not change until 60 ns.  
This 10 ns delay is called the propagation delay of the device.  This slight delay is due to the 
physical gate delay of the gates in the programmable logic device (PLD) required to 
implement the circuit.  In other words, every gate in your circuit has a chunk of PLD 

hardware that is associated with it and an associated physical delay.  With this new 
knowledge, what do you think is the worst delay path in your circuit?   

 
D. Annotating the Simulation 
To add annotations to the simulation, select the large A and then the point on the simulation 
where you want to add a label.  Drag the arrow to a point where you want to add text and type 
the annotation. 
 
E. Printing the Simulation Results  
To print a waveform file, select “File | Print.”  If you want to print only a portion of the 
waveform, select “File | Print | Options” and select the “Time range” as desired. 
 
A poor alternative to the above is to capture a portion of the screen and to then paste this 
captured portion into a word processing or drawing application.  To copy a simulation output (or 
any window on the screen), make it as big as possible and then (while it is the active [selected]) 
window), hit “Alt-Print Scrn” (i.e., hold down the “Alt” and while still holding it, press the 
“Print Scrn” key).  Then paste the captured window into your favorite word-processing or 
drawing program. In your chosen program you can crop and enlarge you figure as desired. 
 

mk:@MSITStore:c:%5Cquartus%5Cbin%5Cquartus.chm::/glossary/def_wavefile.htm
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F. Functional Compilation and Simulation  
When designing something big, it is a good idea to keep a lot of data available for simulation.  
Then, when you know that your design simulates correctly, you can remove as many outputs 
as needed to get the design to fit into your particular device.  Extra signals can be output and 
used in your simulation.  I call these extra outputs debug outputs. 
A functional compilation and simulation has (effectively) no limit on the number of inputs, 
outputs and internal elements available.  Below, I discuss how to functionally compile and 
simulate your design in Quartus. 
First design your parts as usual (either with the graphics editor or in VHDL).  There is no need 
to assign a device to the design.   

• To compile functionally, pull up the “Compiler Tool.”  This tool can be found under 
“Processing | Compiler Tool.”  Select the left-most button under “Analysis and Synthesis.”  
(This button has a triangle point right, an AND gate, and a check mark.) This will compile 
your design without trying to fit it into any particular part.  When your design compiles 
without error, you are ready to functionally simulate.   

• Create a waveform file as you have done previously.   

• Open the “Simulator Tool” under “Processing | Simulator Tool.”  Under “Simulation 
Mode” select “Functional.”  Then select the button labeled “Generate Functional 
Simulation Netlist.”  Check the box labeled “Overwrite simulation input file with 
simulation results.”  Select the “Start” button.  Your functional simulation will now be 
completed. 

The figure below shows the functional simulation of the previous example.  It should be noted 
that the functional simulation will not show propagation delays.  Compare this simulation 
output to the timing simulation output done previously (with propagation delays). 
When you are happy with your simulation results, you can remove the debug outputs you 
don’t really need.  Then go back to the compiler tool to re-compile your design for your PLD.  
Before compiling, make sure to assign the appropriate device for your design.  Now go back to 
the compiler tool and select the “Start” button to do a complete compilation (which will 
include the “Fitter, Assembler and Timing Analyzer”).  Then, in the “Simulator Tool” under 
“Simulation Mode, select Timing.”  Then select the “Start” button.  Your timing simulation 
will now be completed.  The timing simulation will show propagation.  Submit your timing 
simulation (not your functional simulation) for your prelab work. 
Note that state machines and other synchronous circuits should always use timing (and not 

functional) simulations. 
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III. Pin Assignments (when you use Quartus to program a device) 
There are two ways to have a device’s pins assigned to Inputs & Outputs in your Quartus design:  

1. Let Quartus do it automatically and then look them up.  
2. Assign them yourself in the design.   

These two methods are now described. 
 
Quartus Automatic Pin Assignment 
If you don’t tell Quartus what pins to use on your particular device, it will automatically choose 
them for you.  This is actually very good because the software will try to fit your design using all 
the available resources (gates) in the device. This is usually what is usually done when first 
creating a design for a particular device.  You simply compile the design and pins are 
automatically selected.  The question now becomes how do we look up the pins that Quartus has 
chosen for I/O in your design: 

1. You need to open a window called the “Pin-Out File”.  This is done as follows.   
2. On the “Processing” menu select “Compilation Report” and then select 

“Fitter | Pin-Out File”. (There is also a “Pin Planner” icon shown here with a 
pencil on a chip and an “I”.  If you hold your mouse over this “Pin Planner”, 
you will see its name show up right under the icon. You can also find the 
“Pin Planner” under “Assignments | Pin Planner”.  In the Pin Planner, 
select this puzzle pieces icon to “Show Fitter Placements.”)  If you save 
the pin assignments, you will be able to see the pin assignments in the 
lower part of the window.  To save the pin assignments, select 
“Assignments | Back-Annotate Assignments…” 

3. Alternatively, you can select “Assignments | Timing Closure Floorplan”. When you hold 
your mouse over the input signals A, B, C and output Y, you should see it defined as an 
I/O pin one the chip with a pin number designation.   

 
Special Note: Make sure that you assign the device appropriately before compiling your design. 
 
Manually configuring a Pin Assignment (or altering the Quartus Pin Assignments) 
Back annotation allows you to store the pin associations of a design.  Future compilations will 
try not to change these pin numbers.  To execute back-annotation select “Assignments | Back-
Annotate Assignments…”  Select “Pins & device assignments” and then select “OK”.  Pin 
numbers will now appear on the bdf design.  Once you have back annotated your design, if you 
want to change any of the pins, you can select the “Assignment Editor” from the 
“Assignments” menu (or use Ctrl-Shift-A or the button that looks like a pencil 
writing on a blue chip, shown here).  Now you can just re-type the pin number you 
want.  You can alternately move pins around on the Floorplan View.  Again, if any 
changes are made, you must re-compile your design before downloading your design to your 
board.  The figure below shows the default pin assignments from the example we have been 
working on. 
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To show pin locations on the Block Diagram/Schematic file, hit the right mouse key you’re your 
cursor in the Block Diagram/Schematic window.  Select “Show | Show Location Assignments”.  
The pin numbers will now appear (slightly different from above).   
 
Compile your design and verify the signal pins in the Floorplan View or in the Pin-Out File.  
They should correspond to the pins you have set (providing you chose valid I/O pins for the 
particular device that you are using).   
 
If you want to use the pins that you have just defined and make them fixed as you edit your 
design, than under “Assignments” menu select “Back-Annotate Assignments…”  Select “Pins & 
device assignments” and then select “OK”.  You must re-compile your design for the back 
annotation to take effect. 
 
Protecting your Device (Tri-stating unused pins) 
In the default configuration, Quartus will program unused pins as outputs.  These functions of 
these pins can be destroyed if they are connected as inputs.  To prevent this from occurring, 
unused pins should be set as inputs and tri-stated.  To tri-state unused inputs, execute the 
following steps. 

1. In the “Assignment” menu select “Device” 
2. Select “Device and Pin Options”  
3. Select the “Unused pins” tab and then select “As input tri-stated”  

IV. Some More Settings I Use 
In the simulator tool, I suggest that you select “Overwrite simulation input file with simulation 
results.”  This will save time each time you simulate.  Quartus will remember this setting. 
 
Since the propagation delay of most of the devices we now use is 10ns or less, the test vectors 
used in simulation should change much less often than 10ns..  To facilitate construction of test 
vectors with the waveform editor, I suggest that you do the following.  On the “Tools” menu 
select “Options” and then select “Waveform Editor.”  Change the “Default Grid Period” to 
something at least twice as large as the propagation delay of the chip.  I usually use “25ns” or 
“30ns.” 
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A tool bar that I find helpful is available under the “Tools” menu.  Select “Tools”, then 
“Customize,” then “Toolbars.”  Check “Applications” (and leave the “Standard Quartus II” 
selected). 
 

V. Programming your Device 
 
Installing the Drivers 
See the below file on the web for instructions on how to install the drivers for the USB-Blaster 
programming device on Windows 10, Windows 7, Windows Vista, and Windows XP. 
 

http://mil.ufl.edu/3701/docs/quartus/ByteBlaster/USB-Blaster_driver_install.pdf 
 
Connecting your UF-3701 Board to your Breadboard and your USB-Blaster 
The order of connections between the USB-Blaster, your UF-3701 board, and your breadboard 
can be important.  You should make your connections in the following order. 
 
1. Remove power from your breadboard BEFORE inserting your UF-3701 Board without the 

USB-Blaster cable plugged in to either your UF-3701 Board or your computer. 
2. Insert your UF-3701 Board into your breadboard.   
3. Connect the USB-Blaster cable to your UF-3701 Board. 
4. Connect the other end of your USB-Blaster cable into your PC. 
5. Add power to your breadboard. 
 
Disconnecting your UF-3701 Board to your Breadboard and your USB-Blaster 
The order of disconnections between your USB-Blaster, your UF-3701 board, and your 
breadboard can be important.  You should make your disconnections in the following order. 
 
1. Remove power from your breadboard  
2. Disconnect your USB-Blaster cable from your PC. 
3. Disconnect the USB-Blaster cable to your UF-3701 Board. (You could leave this connected.) 
4. Move your UF-3701 board to the proper position on the breadboard.  Verify the power and 

ground connections as well as all other input/output connections. 
5. Add power to your breadboard. 
 
Downloading a Program to your Programmable Logic Device (UF-3701 Board) 
After successfully compiling your design (and installing the Blaster driver), you can program 
your PLD.  Be sure that you have noted the pin assignments or changed them as desired (as 
discussed in Part III of this document).   

1. Start the programmer by selecting “Tools | Programmer”. 
2. Select “Hardware Setup” and then select (double-click on) USB-Blaster (or ByteBlaster 

if you are using a parallel port ByteBlaster).  Then select “Close”.  You should see the 
“USB-Blaster [USB-0]” appear next to Hardware Setup as shown below 

http://mil.ufl.edu/3701/docs/quartus/ByteBlaster/USB-Blaster_driver_install.pdf


University of Florida EEL 3701 Dr. Eric M. Schwartz 
Department of Electrical & Computer Engineering Revision 0 12-Jun-16  
Page 13/14 Quartus Tutorial with Basic Graphical Gate Entry and Simulation 

(Last verified for Quartus II Web Edition v9.1sp2) 

 
3. Select “Add File” to program the appropriate “pof” file (if it is not already listed)..  
4. Make sure that the “Mode” shows “JTAG”. 
5. Select “Program/Configure”.  A check mark will appear in the box.  I suggest that you 

also select “Verify.” 
6. Select “Start” to program your device.  See the message window for information on the 

programming.  You should see a window like below. 
 

 
 
VI. Using SignalTap II Logic Analyzer 
For information on using the SignalTap II Logic Analyzer in Quartus, please see the document 
Tutorial for SignalTap II Logic Analyzer on the class website. 
 

VII. Technology Map Viewer and State Machine Viewer 
To see a block diagram of the parts that Quartus actually uses to create your design (a visual 
representation of the equations files), execute the following steps. 

1. In the “Tools” menu select “Netlist Viewers” 
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2. Select either “Technology Map Viewer” or “Technology Map Viewer (Post-Mapping)” 
 
Another interesting block diagram can be found with the “State Machine Viewer” under the 
“Tools | Netlist Viewers”.   
 
It should be noted that Quartus will separate every 50 nodes onto another page (upper right hand 
corner, “Page x of y”), unless you select to Tools | Options | Netlist Viewers and change “Nodes 
per page” to a higher number. 
 

VIII. Archiving Your Project 
Archiving a project will save the relevant project files into a single compressed file.  You will be 
required to email archive file(s) to an address given in other documents for most of your 
laboratory assignments.  Your TA, the other TAs and the course faculty can each then have 
access to your project files and the files of all the other students in the course.   
 
To make an archive file, complete the following instructions. 

1. In the "Project” menu, select “Archive Project..."   
2. Change the archive name, if necessary, and select "Archive." The archive file will have 

the file name extension qar, e.g., the file name might be “Lab6_part1.qar.” 
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